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Description 5

1 Description

This product is a fully multiband digital audio processor ideal for FM broadcasting.
All audio processing is realized using DSPs, allowing for stable performance ower time and
extending functionality with firmware upgrades.

1.1 Listofchanges

1.1.0 17/06/2014 first release

2.0.0 23/09/2014 updated to new firmware 2.0 features
2.0.1 20/11/2014 updated to new firmware 2.1 features
3.0.0 10/03/2015 updated to new firmware 3.0 features
3.1.0 25/01/2016 updated to new firmware 3.1 features
3.2.0 14/09/2016 updated to new firmware 3.2 features
3.2.1 08/03/2021 updated to new firmware 3.2.1 features

1.2 Warnings

Before attempting any operation, please follow the safety instructions contained in the
following paragraph.

The producer declines any liability for damage to people or things due to non-compliance,
even if partial, of the following indications

« Ensure that the supply wltage corresponds to what is indicated on the apparatus.
« Ensure that the electrical system is equipped with a ground connection.

« Use only power sockets and cables with ground connection

 Disconnect power before attempting any operation inside the device.

» The power cutting device is the power cord, so this should be easily accessible and the socket
must be positioned close to the apparatus.

< Any operation invohing the access to internal parts must be performed only by trained senice
personnel.

© 2021 BEI Electronics LLC



D-PRO-6FM Audio Processor

1.3

1.4

Front panel

Front panel indicators and rotary knob

Headphone stereo jack 6,3mm (1/4")

GATE:
CLIP:

DIG IN:
IP-SDI:

AGC:

MULTIBAND LIMITER:

led is on when lewel is below gate threshold

the analog input level is too high.

AES/EBU digital input is selected as audio source
Network IP is selected as audio source as audio input.

input AGC gain level
multiband limiter compression level

Menus navigation and parameter editing is done through the rotary knob.

Rear panel

Connectors on rear panel

Q

) CEOAN
B-Ze00e
(o)

o) O, 0, Q,
CTRL.

LEFTOUT __ RIGHT OUT RS232

(=] A = N
RIGHTIN 19K OUT/MPXIN MPX OUT SCAIN

(<] ©
DIGIN LEFTIN USBDRIVE _LAN

DIG OUT (XLR M)
DIG IN (XLR F)
LEFT IN (XLR F)
RIGHT IN (XLR F)
19K OUT (BNC F)

MPX OUT (BNC F)
SCA IN (BNC F)

LEFT OUT (XLR M)
RIGHT OUT (XLR M)
RS232 (DSUB 9F)
USB DRIVE (USB-A)
LAN (RJ45)

AES/EBU output

AES/EBU input

Left analog input

Right analog input

19KHz output for external RDS encoder synchronization. (1Vpp
trapezoidal wawe)

Composite MPX output (+6/-6dBm)

External SCA / RDS input (will be mixed to MPX output with a gain of -
20dB)

Left channel analog output

Right channel analog output

RS232 connector

USB connector for fallback audio on external drive (option)

LAN connector for remote control or streaming audio module (option)

© 2021 BEI Electronics LLC



Description 7

1.5

Editing and navigation

Menu navigation and parameters editing is done by the front panel knob.
On the main menu which appears after firmware boot, is possible to select the submenu for the
various settings.

DPRO
Audio Input

ID: STATION NAME

Pressing the knob, will enter the selected submenu.

Once entered in the desired sub-menu, if there are adjustable parameters, you can proceed to
editing

HE Set Input :Digital

Analog lev: @ dB
Dig. lev: B.8 dB
Net lev: ©.8 dB

Pressing the knob, an asterisk "*" will appear next to the first editable element. This will not happen
if, on the current window, there are no editable parameters.

HESet Input:Digital =*
Analog lev:
Dig. lev:
Net lev:

Turn the knob to position the "*" cursor on the other editable elements of the current window.

HES=t Input :Digital
Analog lev: © % dB
Dig. lev: ©8.8 dB

Net lev: B.8 dB

If you want now to change the analog input sensitivity, press the knob again. A "<" symbol will
appear next to the parameter to indicate that this is being edited.

© 2021 BEI Electronics LLC



D-PRO-6FM Audio Processor

HES=t Input :Digital
Analog lev: B < dB
Dig. lev: ©.8 dB

Net lev: B.8 dB

Turning the knob, you now will modify the selected parameter's value.

HES=t Input :Digital
Analog lev: -6 { dB
Dig. lev: ©.28 dB
Net lev: B.@ dB

Once set the desired value, press the knob again. The cursor will switch to "*" again, indicating that
items navigation mode is now active and other items can be selected and edited as described
before.

HE =t Input :Digital
Analog lev: -6 ¥ dB
Dig. lev: B.@ dB
Net lev: ©0.@8 dB

If editing is however terminated, press the knob again and the "*" cursor will disappear and you can
rotate the knob to navigate to other windows.

HESet Input :Digital
Analog lev: -6 dB
Dig. lev: B.8@ dB
Net lev: ©.8 dB

Inside any submenu, pressing the knob for more than 3 seconds, will cause a jump to the main
menu.

Audio Input

ID: STATION NAME

When pressing the knob for 1 seconds, will appear the Headphone Level regulation.

© 2021 BEI Electronics LLC
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D-PRO-6FM Audio Processor

2.1

211

212

Front panel display

Following are listed all menus and functionalities available on the current firmware release.

Audio processor
DPRO& FM

Audio Processor <

ID: STATION NAME

Into this section are comprised all functions and menus related to the audio processor.

AGC

B . 5 . 18

————— e ——— = =
Jate 0 mmeeesssssssssse= = =

Release: 70 » Gate:-40
Link: @ > Drive: 15.0

This window contains the settings for the dual band automatic gain control (AGC) block, placed at
the head of audio processing chain.

The automatic gain control performs a pre-leveling of the signal applied to the following compressors/
limiters, keeping their working point almost constant.

At the right side of the bar which indicates the level of pre-amplification applied to the input signal, is
placed the AGC status indicator: if "gate" indication is off, the input level is above the gate threshold
and the AGC and compressors/limiters are operating correctly, if "gate" indication is on, it means
that the input signal is below the minimum level so the AGC release is slowed down and the AGC
will slowly raise its gain.

Release (...): AGC release time setting (40% fastest, 200% slowest).

Gate: Gate level serring. Below this level, the AGC and multiband limiter release is slowed down.
Link: set the maximum compression difference between the bass and middle/highs band.

Setting this value to zero, the bass compression level will be totally independent and this will cause
also a mild auto-equalization.

Setting this value to 100%, it will force the bass compressor to have a gain never greater than the
middle/highs band giving a sound very close to the original.

Drive: indicates the AGC input driving level, thus determining the AGC maximum gain .

Compression levels

In the window, the gate status and compression-limiting lewvels of the multiband limiters are shown.

© 2021 BEI Electronics LLC



Front panel display 11

2.1.3 Multiband limiter parameters

MbDrive: 10 dB
Release: 120 »

FinalClip Drive: 2.0 dB

MbDrive: multiband limiter drive level.

Release: Multiband limiter release time.

FinalClip Drive: set the wideband final clipper driving lewvel. Higher driving level corresponds to
higher loudness, but will cause higher distortion.

2.1.4 Multiband limiter thresholds

Multiband thresholds
Bl: 2.8 dB BZ2:-3.@

B3:-2.0 dB B4: 0.0
BS: 8.0 dB Bé6: 0.0

All six-bands limiters thresholds are adjustable in order to apply a dynamic equalization according to
the user's taste. Lowering the limiting threshold of any band will result in attenuating the level of that
band, while raising the threshold, will amplify its level.

The six bands cutoff frequencies are :
B1: 100Hz and below

B2: 400Hz center frequency

B3: 800Hz center frequency

B4: 1600Hz center frequency

B5: 3200Hz center frequency

B6: 6400Hz and abowve

2.1.5 Bass parametric eq

BassEqFreq: 80 Hz
BassEqGain: 6.0 dB

BassEq Q: B. 70
Punch Enh z

BassEqFreq: parametric equalizer center frequency

BassEqGain: gain (boost) of parametric equalizer.

BasskEq Q: Q-factor (bandwidth) of parametric equalizer.

Punch enh (0..2): punch enhancer (0 off, 2 max). Give some nice "analog-style" bass enhancing.

© 2021 BEI Electronics LLC
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2.16

2.1.7

EqQO0.7 EQ Freq EqQ14

/
A

\

N
\
/
/

A

\
[
-

Bass clipper/limiter

Bass Clip Thr: - 1.9 dB
Bass Clip Softness: 8

Input HPF :0N

Bass clip Thr:bass clipper threshold.

Bass clip softness: bass clipper cune selection.

Bass clipper will have a cune progressively softer with increasing value.

A softer cune reduces the distortion introduced by the clipping in contrast, setting to zero
(corresponding to the hardest cune), will produce a bass rich in harmonics.

Input HPF (ON/OFF): enables / disables the 30Hz high pass filter for infrasonic component
reduction.

Loading a preset

BEGE MOD MUSIC HOT
BE F28 SPEECH OPN

COMPARE

The "AIR" field shows the on-air preset name, while, in the "TRY" field, can be specified the name of
a new preset to load. Once selected the desired preset, go on the "COMPARE" label which will start
to flash.

When "COMPARE" is flashing, pressing the front panel knob will cause the "TRY" preset to go on-
air while the previously on-air preset will go to "TRY", allowing for comparison.

If Source Dep.Presets function was enabled, it will be possible to specify a different preset for each
audio source  selected so, in this case, the source for which the current preset is used will be
displayed.

Preset for source:DIG

HEl Fol1 MUSIC HOT

F@8 SPEECH OPN
COMPARE EXIT

© 2021 BEI Electronics LLC



Front panel display 13

2.1.8

2.1.9

It is possible to change the audio source from Audio Input menu.

If necessary, make any editing you want to the factory preset (any preset starting with Fxx)
selected, then save the preset to an user memory (Uxx).

Once sawed, the preset will become the audio processing preset for the selected audio source, or
the general preset used for all sources, depending on whether or not the function "Source
Dep.Presets" was enabled.

A modified, but not saved, preset will be marked by the "MOD" prefix. This preset will be overwritten
if a new preset is loaded and then edited.

Mode FOO: BYPASS, has the input level as the only editable parameter and this is the same both
for the Analog / AES EBU source and NetAudio.

In the case where it is necessary to put have the processor in bypass mode when any of the two
sources are selected, it will be possible to compensate the differences in audio levels, if any,
adjusting their input levels from the audio input menu.

If one of the sources is the Analog channel, we recommend to set the input level of the AD
converter in coarse 6dB steps, then use the bypass input level for fine tuning of Analog source, then
adjusting the level of the other channel, netaudio or AES EBU, from the audio input menu

Saving a preset

Curr.Preset Name: EXIT
MUSIC HOT

Store to: SAVE
P:USER @

Curr Preset name shows the name of the preset which is actually on air The name can be changed
following the editing rules described before. When name editing is finished, the "*" cursor will be
positioned to the right side of the name string and will allow to move on the other editable elements
on the window.

Once the preset name has been edited, you can choose an user file to store it, then go to "SAVE"
button which will start to flash. Pressing now the knob will result in saving the preset to the specified
user file.

Bypass
Bypass Drive: 0.0 dB

If the selected process is "FO0: BYPASS", the only editable parameter will be the input level.
No other parameter is used, so the other editing windows will be hidden.

© 2021 BEI Electronics LLC



14 D-PRO-6FM Audio Processor

2.2 RDS Coder

DPRO&6 FM
RDS Generator

ID: STATION NAME

Into this section are comprised all functions and menus related to the optional RDS encoder.

2.2.1 RDSlevel and flags

RDS: ON LEV:3.0 KHz
TP:OFF TA:OFF RT:OFF

MS:MUS COMPR: ON AH:OFF

RDS(ON/OFF): sets the coder on and off.

LEV: RDS subcarrrier level

TP (ON/OFF): sets the TP flag status

TA (ON/OFF): sets the TA flag status

RT (ON/OFF): radiotext enable

MS (MUS/SPC): sets the MUSIC/SPEECH flag status

COMPR (ON/OFF): sets "COMPRESSED" flag status

ARTIFICIAL HEAD (ON/OFF): sets "ARTIFICIAL HEAD" flag status

The "mono/stereo” flag is switched automatically, depending on the MPX modulation type selected.

222 PILPTY

PIl:5330
PTY:89 Varied

Pl: Pl code setting
PTY: Program Type, settings

Changes will tak e effect once saved.

© 2021 BEI Electronics LLC
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2.2.3

224

225

PS and Radiotext monitor

PS MON iMY RADIO |
RT MON My Radio My best

radio in town

PS MON: Program Station Name actually on air.

RT MON: Radiotext actually on air.

If the Radiotext Plus is active for the currently aired Radiotext string, a "+" symbol will be appended
to the "RT" label.

Radiotext Plus, Dynamic PSN and CT (clock time) functions are available using the supplied
software RD-Link

PS Editor

PS 1 :MY RADIO

Dur(secs): 2 SAVE DEL

In this window you can enter and edit PS strings that will be displayed by the receiver, each of which
can be up to 8 characters long.

PS 1..24: selection of the item to edit.
Dur (secs): display time, in seconds, of the currently selected string . A duration of zero, will disable
the display of the string.

SAVE: Sawe the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

RT Editor

RT 2<{:My Radio My best
radio in town

Durimins): 1 SAVE DEL

In this window you can enter and edit RT strings that will be displayed by the receiver, each of which
can be up to 8 characters long.

RT 1..24: selection of the item to edit.
Dur (mins): display time, in minutes, of the currently selected string . A duration of zero, will disable
the display of the string.

© 2021 BEI Electronics LLC
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2.2.6

SAVE: Sawe the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

AF list Editor

AfList: 1 Fregs:14
Freqg #: 1 181.0©

Freq INSERT DELETE
List SAVE CLEAR

Alternative frequencies editing window .It is possible to insert up to 25 frequencies on the first list for
the method "A", or 24 lists for method "B". For more details on the differences between the A and B
modes, please refer to the AE List window of programming software.

AfList 1 ... 24: selection of the AF list to be edited.

Freqs: indication of the number of frequencies into the selected list.

Freq #: selection of the frequency number in the list, from 1 to 25, to be edited.

Freq INSERT: Insert a new frequency in the "Freq #" position. The other frequencies in the list will
be shifted accordingly.

Freq DELETE: the current frequency will be deleted.

List SAVE: sawes the changes

List CLEAR: deletes all frequencies in the current list

Notes:

The list, once modified, will be used only after it has been saved using the SAVE button. Selecting
a different list (AfList) or exiting the editing window before saving the list, will result in losing all
changes.

Any empty frequencies (--.-) eventually contained into the list, will be deleted automatically upon
saving.

© 2021 BEI Electronics LLC



Front panel display 17

2.3

231

2.3.2

Audio input setup

DPRO&6 FM
Audio Input

ID: STATION NAME

In this section are present all controls related to audio sources and automatic audio fallback

Audio levels monitor and input level setting

In the current window is displayed, with greater accuracy, the input level of the selected channel.

The input level of the selected channel can be adjusted, but the channel will not be put on air.
To change the on air input channel, the following window must be used.

Audio source setup

Audio input:  Analog, analog input
Digital, AES/EBU input
NetAudio, streaming audio input.

Analog lev: audio input attenuator level. This adjustment sets the input level to the A / D converter.
The nominal level is indicated in the bars:

Set Input :Digital
Analog lev: 9.8 dB

Dig. lev: 0.0 dB
Net lev: .80 dB

The initial adjustment of the input level should be made so that the maximum analog input level is
equal to or only slightly abowe that limit.
In no case the front panel "CLIP" led should light.

Dig. lev: AES/EBU level adjustment
Net lev: streaming module level adjustment.

The adjustment of the individual channels is in 0.1dB steps.

© 2021 BEI Electronics LLC
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2.3.3

234

Audio processor preset selection

Preset for source:DIG

Gl Fo1 MUSIC HOT

IE F28 SPEECH OPN
COMPARE EXIT

If Source Dep.Presets function was enabled, it will be possible to choose a different preset for each
audio source, which can be selected in the previous menu, otherwise this window will not be visible.
Once selected a preset, it can then be edit into the Audio Processor section.

The loaded preset will be assigned to the audio source currently on air.

Audio fallback setup (audio backup)

The processor can be set to automatically switch to an auxiliary input source if the main input audio
level is below a minimum threshold.

Fal lback:0FF OnAir:DIG
x [1:ANA AlmTime : 30

o [12:DIG BackTime:120
o I3:NET AlmThr: -68 dB

Fallback (ON/OFF): Enable / Disable automatic audio fallback on backup source.

OnAir: audio source actually on air

11 - 12 - 13: Channel list. The channel are listed by order of priority, with maximum priority assigned
to channel 1.

When an high priority channel will become unavailable, it will be replaced by a lower priority one until
its recovery.

AlmTime: Alarm timeout

Back Time: Back timeout. It is the time for which the main audio source must be abowe the
minimum threshold before it can be set back on air.

AImThr: minimum audio lewvel threshold

The main audio source is considered valid If the level of both channels L / R are above the alarm
threshold. If a single channel is less than the alarm threshold for a period longer than the alarm
timeout, the backup source will be put on air.

When the main audio source will recover, once elapsed the "Back Timeout", it will be put back on
air.

Changes will be applied upon exiting the menu.

© 2021 BEI Electronics LLC



Front panel display 19

2.4  Audio output setup

DPRO&6 FM
Audio Output

ID: STATION NAME

This section contains the settings relating to the DIG OUT - L R OUT audio outputs.

2.4.1 Audio output regulation

ANA Out lev 0.0 dBu
DIG Out lev -6.0 dBFS

QUT deemph SEUS
Qut pos: clip&Filt

ANA LR Out : audio output level on rear XLR Left-Right OUT connector.
DIG LR Out : output audio level on rear XLR DIG OUT connector
Out deemph: output audio deemphasis. This is related only to the audio output, not to MPX output.
Out pos: point of acquisition of the output signal, it can be selected form:
Post clip&flt: output signal is taken after clipper and lowpass filter.
Pre filter: output signal is taken prior the lowpass filter, but after the clipper.
Pre clipper: output signal is taken before the clipper.

2.5 MPXoutput setup

DPRO& FM
MPXx Output

ID: STATION NAME

25.1 MPX modulation and pilot subcarrier setup

Modulat ion Stereo
Preemphasis: Sbus

Pilot Level: 5.0 KHz
Pilot Phase: 8.00 Deg

Modulation (stereo, mono I+r, mono L, mono R):

Stereo: stereo modulation

Mono L+R: monoaural modulation from L+R channels sum.

Mono L, Mono R:monoaural modulation from a single channel.
Preemphasis: 50/75uS preemphasis, it should be set according to local FM broadcasting
standards.

© 2021 BEI Electronics LLC
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252

Pilot level: 19KHz pilot tone injection level.
Pilot Phase: pilot tone phase adjustment.

Output level setup

Audio level : 89 b4
Composite lev: 0.8 dBu

Test Tone (1Y):0FF

Audio level: percentage of audio signal (L+R, L-R) into the composite MPX signal.

In case of monoaural broadcasting, without RDS and pilot subcarrier, this level can be left at 100%,
and this will produce a deviation of 75KHz.

In all other cases it should be reduced according to the lewel of injection of the two subcatrriers,
otherwise overmodulation will occur.

For example, if a RDS subcarrier of 2KHz and a pilot tone of 6KHz are desired, the audio signal lewel
can not be greater than

100*(1- ((PilotCarrierDeviation+RDSCarrierDeviation)/75))
which, for the example described above, will correspond to:
100*(1- ((6+2)/75))=89.3%

Composite level: MPX output level.

Test tone (!): when activated, will put on air a 400Hz tone, having an amplitude equal to 100%
modulation.

If RDS and pilot subcarriers were correctly set, the final modulation will not go abowve this limit.
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2.6

26.1

2.6.2

System setup

DPRO&6 FM
System

ID: STATION NAME

Display, Source Dependent Presets, Device ID

Contrast: 16
Source Dep.Presets:0OFF

ID:STATION NAME

Contrast: display contrast adjustment.
Source Dep.Presets: enable/disable audio preset selection depending on audio source.

ON: if the function is enabled, a different audio processing preset can be specified for each
audio source.

OFF:if the function is disabled, the same preset will be used for all audio sources.

ID: device identifier. It is a 16 characters long label which will be shown in the main menu screen,
useful for identification when multiple devices are installed.

GPland MPX changeover option (Split)

76543216
GPI status : QDA

Split ctrl port:O0FF
Invert split status:0FF

In this menu it is possible to remotely select the channel to be broadcast or manage an MPX
adwertising split in output (option). The election is possible via GPI, serial and Network card.

GPI status: status of the 8 available ports, from 7 to 0.

Split ctrl port: enable the function and select the communication mode.
OFF: disabled function.

GPI: active function on CTRL port.

Serial: active function on RS-232 port.

Network: active function on Ethernet port.

Invert split status: invert commutation MPX Input set on GPI mode
OFF: without command it is set in [NETWORK] mode.
ON: without command it is set in [SPLITTING] mode.

The split status is shown at the top of the display.
In [SPLITTING] mode, in MPX output there is the processed signal coming from Analog or Digital
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Inputs or Net Ip stream (if present).
In [NETWORK] mode, in MPX output, the signal applied to MPXIN is present.

Rear Connectro GPI (CTRL)

GPI port status:

: Pin 6 - Set ANALOG Input

: Pin 2 - Set DIGITAL Input

Pin 7 - Set NET/IP Input

Pin 3 - Set MPX Input (SPLIT)
Pin 8 - Not used

Pin 4 - Not used

Pin 9 - Not used

: Pin 5 - Not used

NoahRhRwNhMROQ

DB9M

Not Used e
Not Used - (@& 4 (9 Not Used

Not Used
Set MPX Input (SPLIT)- 83 © orrse

Set NET/IP Input
Set DIGITAL Input -8 2 g Set ANALOG Input
GND

The inputs are activated by grounding the relative pin or by providing a wltage from 5 to 12VDC, in
this case the jumpers placed on the board inside the device will have to be moved from the "CLOSE"
to "VIN" position.

The selection of the channels through the GPI port takes place with exclusive priority on a single
channel, if more inputs are activated at the same time the channel is restored before the selection,
only the MPX channel has absolute priority and at each activation it does not take into account the
status of the other 3 inputs by bringing the MPXIN signal to MPX OUT.

Example 1: the Analog channel is on the air, pin 2 is activated by broadcasting the Digital channel,
at the same time pin 7 NET / IP is also activated, since the selection of two channels is not valid at
the same time, the channel returns to air Analog.

Example 2: the Digital channel is on the air, pin 6 is activated by broadcasting the Analog channel,
at the same time the MPX pin 3 is activated, the analog channel remains active but the MPX output
is switched to MPXIN.

Network command by lan:
By selecting Network on "Split ctrl port” commands can be sent via LAN using the UDP protocol
with standard ethernet card, the TCP protocol with IP Streaming option card.

[AB010103] select analog input

[AB010200] select digital input

[AB010301] select NET/IP input

[AB010406] / [AA010001] select MPX input
[AB010002] o [AA010100] return on main channel

The selection command must be repeated continuously otherwise the device re-enters the main
channel.
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2.6.3 PassCode Setup

User Password: 0 % 5)%]
Autologout (mins): 3

LOGOUT

User Password: in this section the user can enter a numeric password that will be required for
accessing the device. Setting "0000" (default value) will disable the password prompt.

Autologout (mins): Automatic lock timeout. If no action is done on the front panel knob within the
specified time interval, the device will enter into lock state and the user will need to re-enter the
password to log in again.

LOGOUT: immediate logout and lock.

SAVE: Sawes any changes made to the numeric password or the duration of the automatic logout
timing.

2.6.4 Ethernet setup

IP : 192 168
GWY : g @ 0 0

Port : 548000
NetMask: 24

IP: current ip address

GWY: gateway address

Port: UDP port number

NetMask: netmask in CIDR notation.
APPLY: apply and save changes.

This page is visible only if the network module is installed.

2.6.5 System info

Sys: operating firmware release

Proc: audio processor and MPX coder firmware release
Hw: hardware release

BL: MCU bootloader release

SN: serial number
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2.6.6

2.6.7

Options

PURCHASED OPTIONS
%% G155 515 55 % %1% 5 510 5 % 0 G

ENTER

In this window the user must enter the code to enable the optional features.

Once entered the code for the desired option, go to the "ENTER" button and, when it will flash, push
the front panel encoder.

The device will verify the code and, if found correct, will activate the requested option.

Example for RDS coder:

OPT IONS
%% %1% % %1% %% % %1% 5 %1% %15 % G
[RDS]

ENTER

Login window

To protect the device from unauthorized operation, a security code can be enabled by accessing the
System menu, Set password.

When the device is turned on (or the auto logout time is elapsed), the login page will be shown
where the pass code is to be entered.

Passcode

%5505 LOGIN

LOGIN: when the correct pass code is entered, will log in user.

Pass code lost or forgotten: after the 20th unsuccessful login attempt, an unlock code will be
displayed.Call customer senice and tell this code in order to get back your pass code.

Passcode

Unlock 330DB3

55505 LOGIN

© 2021 BEI Electronics LLC



Front panel display

2.7 Headphones Level

The headphone lewvel can be adjusted using the front panel knob.
Pressing the knob for more than 1 second, will show the adjustment level menu.

Headphone Level
|

After 3 seconds the level menu will close automatically.

25
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3 Programmming software

A PC based softwareMultiband Processor Programmer, compatible with 32 and 64 bits Windows Xp,
Windows 7, Windows 8.X, Windows 10, is provided for processor remote control and setup.

Connection is done through:

e serial port 9600 baud 8N1

e ethernet port TCP-IP (if optional streaming module is installed)
e ethernet port UDP

3.1 Main window

In the main window the type of connection can be selected, via COM port or through Ethernet port
using TCP-IP (needs streaming module) or UDP (needs ethernet module). Once the communication
mode is set up and the processor connected, press "Connect". If communication is correct, the
program will read all internal settings and device information.

MultiBand Processor Programmer
=
PazsCode Proc =
Abort
Connection
Comm Interface

® Serial
Serial port: COM1:Porta di comunicazione (CC
% Disconnect

Get Info

Station ID STATION NAME Update
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3.2 Processor Params

This section contains the audio process controls and presets, setting of the audio input and output
sources and system parameters.

3.2.1 Processor Presets

On this page are shown the input lewvels, the audio input currently on air, the presets list and the
audio processing parameters.

Connection ~ Processor Params
OnAir : TOP 40 (src dep.) Processor Presets
TOP 40
Multiband
Multiband Drive dB

Band 1 Compressor Threshold dB

Band 2 Compressor Threshold dB

Band 3 Compressor Threshold dB

Band 4 Compressor Threshold dB
Band 5 Compressor Threshold dB
: Band & Compressor Threshold dB
IJ;EIEE g’ Denoiser
Multiband Release Time % (lower =faster)
Final Clip Drive dB

Briliance %%

Update

All presets are listed and, with a double click, is possible to recall a preset and put it on air.
Factory presets are displayed in blue background, user definable presets in green and, in orange, a
modified preset not yet saved.

The modified preset (in orange) will be usable until a new preset is loaded and then modified.
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On the same page are present the audio processing parameters. For a detailed description of each
parameter, please refer to the audio processor section:

Processor Drive, Gate Level

AGC Enabled, AGC Speed

Compression, Master Release

Band Link, Brillance, Presence

Bass Lim Thr, Bass Lim Presence, Bass Clip Threshold, Bass Clip Softness

Bass EQ, Bass E Bass EQ Fre

Expander Level, Stereo Expander Enabled

Read: read the parameters setup from the processor

Update: send the modified audio processing parameters to the processor: when a factory or a user
preset is modified, a temporary preset will be created. The Save Onair button will be enabled to
sawve the preset once changes are terminated. The preset name can be directly changed in the
preset name editor.

Then,pressing the Save OnAir button, it will be possible to select the destination user preset.

ct destination preset
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3.21.1

AGC

AGC Drive dB 20,0

100
Gate Level dB

Band Link %%

This window contains the settings for the dual band automatic gain control (AGC) block, placed at
the head of audio processing chain.

The automatic gain control performs a pre-lewveling of the signal applied to the following compressors/
limiters, keeping their working point almost constant.

At the right side of the bar which indicates the level of pre-amplification applied to the input signal, is
placed the AGC status indicator: if "gate" indication is off, the input level is above the gate threshold
and the AGC and compressors/limiters are operating correctly, if "gate" indication is on, it means
that the input signal is below the minimum lewvel so the AGC release is slowed down and the AGC
will slowly raise its gain.

AGC Drive: indicates the AGC input driving lewel, thus determining the AGC maximum gain .

AGC Release Time: AGC release time setting between 40% fastest and 200% slowest.

Gate Level dB: Gate level serring. Below this level, the AGC and multiband limiter release is
slowed down, the signal below this threshold it is no longer considered processable.

Band Link %: set the maximum compression difference between the bass and middle/highs band,
increasing this value the two band link together.

Setting this value to zero, the bass compression level will be totally independent and this will cause
also a mild auto-equalization.

Setting this value to 100%, it will force the bass compressor to have a gain never greater than the
middle/highs band giving a sound very close to the original.
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3.2.1.2 Multiband
Multiband

Multiband Drive dB

Band 1 Compressor Threshold di
Band 2 Compressor Threshold di
Band 3 Compressor Threshold di
Band 4 Compressor Threshold dB
Band 5 Compressor Threshold dB
Band & Compressor Threshold dB

Denoiser

Multiband Release Time %6 (lower =faster)

Final Clip Drive dB

Brilliance %%

All six-bands limiters thresholds are adjustable in order to apply a dynamic equalization according to
the user's taste. Lowering the limiting threshold of any band will result in attenuating the level of that
band, while raising the threshold, will amplify its level.

Multiband Drive dB: indicates the multiband limiter driving lewvel, thus determines how much the
multibands will work and so re-equalize the program.

The six bands cutoff frequencies are :

Band 1 Compressor Threshold dB: 100Hz and below

Band 2 Compressor Threshold dB:: 400Hz center frequency
Band 3 Compressor Threshold dB:: 800Hz center frequency
Band 4 Compressor Threshold dB: 1600Hz center frequency
Band 5 Compressor Threshold dB: 3200Hz center frequency
Band 6 Compressor Threshold dB: 6400Hz and abowve

Denoise: Denoiser. If activated, it will monitor the high frequency content of the audio input signal,
reducing the band 6 gain when HF input level is too low. It can be used to reduce noise coming from
old tape recordings.

Multiband Release Time % Multiband release time setting between 40% fastest and 200%
slowest, making the multiband faster increases the loudness.

FinalClip Drive dB: set the wideband final clipper driving lewvel. Higher driving level corresponds to
higher loudness, but will cause higher distortion.

Brilliance: Brilliance high band (>6KHz) shelf equalizer, increasing the value produces an increase
in the high frequencies.
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3.2.1.3 Bass EQ

Bass Equalizer gain dB

Bass Equalizer Q

Bass Equalizer Frequency Hz

Punch
Bass Clip Threshold di

Bass Clip Softness

Bass Equalizer gain dB: gain (boost) of parametric equalizer.

Bass Equalizer Q: Q-factor (bandwidth) of parametric equalizer, increasing this value the filter
becomes more selective around the center frequency.

Bass Equalizer Frequnecy Hz: parametric equalizer center frequency

Punch: punch enhancer (0 off, 2 max). Give some nice "analog-style" bass enhancing.

Bass Clip Threshold dB: bass clipper threshold, the threshold beyond which the bass clipper
begins to cut.

Bass Clip Softness: bass clipper cune selection.

Bass clipper will have a cune progressively softer with increasing value.

A softer cune reduces the distortion introduced by the clipping in contrast, setting to zero
(corresponding to the hardest cune), will produce a bass rich in harmonics.
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3.2.2 Audio input-output

This page allows for selection of on air audio input, changing audio output parameters, setting up the
audio fallback and the source dependent presets.
Processor Params
OnAir : TOP 40 AUDIO Input-Output

Audio Input AFS EBU Source dependent presets

Analog In Level dB 0,0 Preset for analog TOP 40

skl T L el 0.0 Preset for digital DEEP BASS

s inilened o 0,0 Preset for netwaork BYPASS

Network In Level dB 0,0 _ -
Analog Output Mode  Clipped and filtered

Analog OutLevel dB8 0,0

AES Out Level dB 60 Analog Output Deemphasis a0us

Input 30Hz HPF

7

Analog input -

Alarm Timeout 5
Back Timeout S
AESEBU -

Analog input - Alarm Threshold dB

Update

For a detailed description of the following parameters, please refer to audio input setup, audio output
setupand source dependent presets

Audio Input, Analog InputLevel, Digital InputLevel, Network InputLevel
Bypass InputLevel

Audio OutputLevel, Audio Output Mode, Audio Output Deemphasis.
Audio Backup Enalbled

Source dependents presets

Input 30Hz HPF: enables / disables the 30Hz high pass filter for infrasonic component reduction.

Read: read parameters from the processor
Update: send changes to the processor
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3.2.3 System setup

In this page it is possible to enable and adjust the optional RDS encoder carrier level, the pilot
carrier, insert and adjust the network parameters.
MultiBand Processor Programmer Ver, 31.0.28
%

PassCode Processor System |
- Abort

Prion it Params

-25 I-I'Z
-20 |II—-
5 | - -

OnAir : LOUD

RDS Enabled
MET IP

RDS Level KHz 2,0 192

-12

-6
5 | Pilot Level KHz 8,0 MET MASK
b 255 ., 255

_ | Pilot Phase ® 0,00
13 10 . MET GATEWAY
12 Modulation STEREQ
-10 --15 .18 | Preemphasis 50uS —
’ - ) : NET PORT 54000
MPX Out Level dB 0,0

30| Mpx Audio Level % 83

Update

The network parameters are related to the optional network module only. If the streaming module
was installed, network configuration will be done through the web server of the module.

For a detailed description of the following pararmeters, please refer to MPX output setup and System
setup

RDS_Enabled. RDS lewel. Pilot Lewel. Pilot Phase. Modulation. Preemphasis. MPX Output Level,
MPX Audio Lewel
NET IP, NET MASK, NET GATEWAY, NET PORT

Read: read parameters from the processor
Update: send changes to the processor
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3.3 Loading and saving a preset

All the audio presets customized by the user can be sawed in files, this preset can be transferred to

another DPRO or sawed in an external drive.
The remote control software allows to load and save the audio processing presets through the

File>Processor menu:

Save Usr Presets to Disk

Cercain: I ) Usr Presets j - fj‘ '
T Mome ° Ultima modifica Tipo
- b
. e ' __|USR 01 LOUD M BASS MOD.dpro6 19/02/2015 1843 File DPRO
Risorse recerti
__| USR 02 BASS LIM+.dpro6 20/02/2015 09:50 File DPRO
- || USR 02 BRILLANCE UP.dpro6 19/02/2015 18:53 File DPRO
Deskiop
Raccolte
Computer
= 4 1 | +
A
Rete Mome file: IUSF! 02 BASS LIM=.dprob j Apri |
Tipo file: |DPRO Fies ~|  Amnula |

the on air preset will be saved to disk.

Load Usr Presets to Onair

Load pre: o Cndir

. Salva con nome | 2 ‘
Salva in: I |/ Usr Presets j & £5 B~
= Mome = Ultima modifica Tipo
-~
. i . L |USR01 LOUD N BASS MOD.dpro6 19/02/201518:43 File DPRO
Risorse recenti )
|| USR 02 BASS LIM+.dpro6 20/02/2015 03:50 File DPRO
" | USR 02 BRILLANCE UP.dpro6 19/02/201518:53  File DPRO
Desktop
=
Raccolte
A
Computer
@ 1 n | r
Rete Nome file |Us 00 USER 0_dprog =] saha |
Salva come |DPROS Flles x| Amnula |

the preset loaded will be put on air.
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Loading and saving system

The remote control software allows to load and save the system configuration through the "System"
menu, and this includes all parameters listed under "System" and "Audio Input-Output" tabs.

Save System config to Disk

Load Systern Configuration

Save System Ceonfiguration

Salvain | Audio Processor j I‘j‘ E~
|-_._ Mome = Tipo Dimensione
b - -
Risorse recenti | System conf!g mod.dprobsys F!Ia DPROGSYS 2KB
| System config.dprobsys File DPROGSYS 2KB
Desktop
Raccolte
LY
Computer
= %
“w
Rete
4 T | +
Mome file: |System corfig mod.dproGeys j Salva |
Salva come |DPROBSYS Files j Annulla

the system configurationi will be saved to disk.

Load System config from Disk

Load System Configuration

ave System Configuration

Cerca in: | Audio Processor j £ B
= Mome = Tipo Dimensione
s
=¥ [ 5ystem config mod.dprofisys File DPROGSYS 2KB
Risorse recenti - -
|| System config.dprobsys File DPROGSYS 2KB
Deskiop
Raccolte
L "
Computer
e J
A
Rete
4 1 | [*
MNome file: |Sy5tem corffig dpro6ays j Apri |
Tipo file: [DPROBSYS Fies =] Annula

the system config preset loaded in.
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3.5 RDS

RDS configuration pages will be visible only if the optional RDS coder was enabled.

3.5.1 RDS Flags window

Flags
Current Page

Skation ID STATION MAME
Read

Program Twvpe Country

09: Varied

Fi .
W Music
Ak

-~

~ Compr

' Enable Rad

all RDS parameters

Coder

Program C

Abort

This window contains the configuration parameters of the RDS encoder.
RDS ENABLED: enable RDS coder.

PTY: Program Type

Set the program type.

Many receivers are equipped to select the received stations based on the format preferred by the
listener.

Pl:Program Identification

Identification code of the station.

The code consists of 4 digits, the first digit indicates the country of origin, the second represents the
area of coverage and the last two identify the station into its coverage area.

First digit, the country of origin of the program. You may write it directly into the “Pl Code” editbox or
select it using the “Country” dropdown list.
A list of some country codes is reported in appendix A.

For the second, according to the coverage area, choose one of the following codes:

0 local cowverage, the station is supposed to have one frequency only
1 International coverage
2 National coverage
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3 Supra-regional coverage

4..F area codes for regional coverage stations

Note: the local coverage code “0” is intended for stations having one_frequency only, so its use is
intended just in this case. If the station has more than one frequency, a supra regional (3) or
regional code (4 to F) must be used.Using the local coverage code (0), make many receivers to
ignore the alternative frequencies tables.

The two last digits uniquely identify the station into its coverage area and shall be different amongst
all other stations broadcasting over the same area.

Some examples:

5001.: Italian radio station (5) local coverage (0, program identifier code 01
5202: Italian radio station (5) national coverage (2), program identifier code 02
B54AF: ltalian radio station (5) regional coverage (4, program identifier code AF

TP: Traffic program
This flag indicates that your station, during normal programming, broadcasts traffic programs.

TA: Traffic Annonunce

Traffic Announce on air.

This flag should be set when traffic related news are being broadcasted.
For this reason, the TA flag can be switched by the external control port.

MUSIC: This flag indicates if the station main format is music or speech.

Some receivers use this information to apply a different tone equalization or wlume according to
whether music or speech is being broadcasted.

It is possible to switch this flag externally, using the external control port.

ARTIFICIAL HEAD:This flag indicates that the program was recorded using an artificial head.

This device is a dummy human head with two microphones inserted into the auditory canals, used
during the recording process of the performance or live event, to accurately reproduce the original
spatiality.

COMPRESSED: This flag indicates that the program was compressed.

ENABLE RADIOTEXT:Flag to enable radiotext group (2A) transmission.
If disabled, only OA groups will be trasmitted.

STATION ID:This 16-chars string can be assigned to the coder for its identification.

It could be its destination, the site to which the encoder is assigned, or the name of the radio which
owns it.

It will not be shown anywhere else, neither transmitted into any RDS block; it is only a label to
identify the processor.
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35.2 PSwindow

Conneckion RDS Generakaor

PS

PS Duration {secs) Current Page

MYRADIO
Read

Modified

Program Coder

Abort

o oo o o o o o o o o o o o o o oo B

In this window, It is possible to enter the program station names, each of which can be up to 8
characters long.

For each string you can set the display duration time in seconds.

A duration time of 0, disables the corresponding string.

READ: read all PS strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified entries
CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.
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3.5.3

Radiotext window

RDS Generakaor

RadioText

Duration {mins) Current Page

My Radio, best skakion in bovn

¥es, it is really the best

1
Read

Modified

Program Coder

Abort

In this window, It is possible to enter the radiotext strings, each of which can be up to 64 characters

long.

For each string you can set the display duration time in minutes.

A duration time of 0, disables the corresponding string.

READ: read all radiotext strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified Radiotext entries

CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.
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354 AF Lists window

Flags AFList
Freg Info I aflist 1 E Current Page
AF 1 101.0 —
. Read

AF 2 104.4 Aflist2
AF 3 104.5 Af list3
AF 4

Af list4
AF 5
AF B Af list5
AF 7

Af list6
AF &
AF 9 Af list7
AF 10 Clear all

Af list 8
AF 11 all RDS parameters
AF 12 Af listg

Read Coder
LA Af list 10
AF 14 P Zod
ogran Coder

AF 15 Aflist 11 i
AF 16 Af list 12 Abort
AF 17
e w || &f list 13

The RDS encoder allows for method "A" or "B" for alternative frequencies coding.

The choice between the two methods depends on the structure of the network and the number of
alternative frequencies.

There is no flag which indicates if the alternative frequencies are transmitted by method "A" or "B":
the difference between the two methods is encoded in the way the frequencies are disposed into the
list.

Notes:

It is not possible to compile different lists using the A and B simultaneously.

“A” method should be used only when the network has a maximum of 25 frequencies and does not
differentiate regional programming.

“B” method is used when the alternative frequencies are more than 25 or when, within the same
network, there is a program differentiation, such as local news or advertising, only on certain
frequencies.

The lists must be compiled starting from the first and should be filled leaving no empty lists in
between: any empty list will be automatically removed upon coder programming.
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3.54.1

Editing

Af list1 Current Page

Af list2 Read

Clear lisk Af list 3
Sort Frequencies
Build B List
Insert

w'rike

Af list4

Af list 5
Rermone

Af list6

Af list7
Clear all

Af list 8
all RDS parameters

Af listg

Af list 10

AF list 11 Program Coder

Af list 12 Abort

Af list 13

The frequencies must be inserted starting from the first list “Af list 1", cell AF1.
Right-clicking on the list, a popup menu will appear allowing to:

Clear list: the current list will be cleared

Sort frequencies: the frequencies inserted into the current list will be sorted in ascending order
Insert: insert a new frequency at the selected cell position

Remove: remowve the frequency at the selected cell position
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3.5.4.2 A Method

This is the simplest method and it is indicated for all those stations which have a maximum of 25
alternative frequencies and do not provide regional - differentiated programming.

To implement this method, simply insert in AF List 1 all frequencies of the station in ascending
order.
No other list must be filled.

Example:
88.1

91.3
104.1
104.5

3.5.4.3 B Method

This method is used where the number of alternative frequencies used in a network exceeds 25, or
where it is required to indicate frequencies which belong to different areas which at times carry
different programs.

Each transmitter and associated repeater stations broadcast the same set of different AF lists in
sequence.

The number of AF lists within a network is in general identical to the number of transmitters and
repeater stations in the network so as to provide a unique list for each transmitting station. In this
protocol the alternative frequencies for the VHF/FM transmitters are individually addressed by
transmitting the tuning frequency paired with one alternative frequency within one block.

Each list starts with the tuning frequency for which the list is valid.

All remaining pairs (up to 12) give the tuning frequency together with a valid AF.

Usually, the tuning/AF pair has to be entered in ascending order if the AF is not a regional variant of
the tuning frequency, on the contrary the order has to be reversed.

If the number of AFs of a station is larger than 12, the list must be split into two or more lists. These
lists are transmitted directly one after the other, and the receiver must combine the lists again.

If a transmitter frequency is used more than once within a network the respective AF lists are
transmitted separately. In order to indicate that these lists with the same tuning frequency belong to
different stations, the lists must be separated by AF lists of other stations.

To simplify the programming of a B list, put into the first line AF1 the main tuning frequency, then
enter on the other lines (AF2 to AF13) a maximum of 12 alternative frequencies, then press the
button "Build B list.”

If you, in future, wish to add some new frequencies to the list, simply enter them at the bottom and
press the button "Build B list again.”
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& Current
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Freq Info | aflist 1
AF 1 90,0 =
AF 2 1045 Af list2
AF 3 e Af list 3
AF 4 105.2
Af list4
AF 5 1067
AF 6 104,9 Af list 5
AF 7
Af list6
AF 8
AF9 Af list7
AF 10
Af list 8
AF 11
AF 12 Af list9
T Af list 10
AF 14
AF 15 Af list 11
AF 16 Af list 12
AF 17
w || &f list 13

The main frequency (90.0MHz) is put in the first AF cell (AF1) and all alternatives are following from
AF2 to AF6.

Flags AFList
Freq Info | aftist 1 Current Page
AF 1 Q0.0 Main Freq —
AF 2 90.0 Main Freq Aflist2
AF 3 93.5 Af list 3
AF 4 Q0.0 Main Freq
Af list4
AF 5 104.5
AF 6 20.0 Main Freq Af lists
AF 7 104.9
Af list6
AF 8 Q0.0 Main Freq
AF 9 105.2 Af list7
AF 10 Q0.0 Main Freq .
Af list8
AF 11 106.7
AF 17 Af list 3
LAt Af list 10
AF 14 P o
. 'rograrn Coder
AF 15 Af list 11
AF 16 Af list 12 Abort
AF 17
Sekia w || AF list 13

Right click on the list and select the “Build B List” command: the list will be compiled using "B"

method.
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3.5.5 Loading and saving RDS coder configuration

The remote control software allows to save and reload a complete RDS coder configuration through
the File>RDS menu:

Load Configuration

Load Configuration

Configuration

Cercain | 23 Ust Presets v| €] 5 S
) Rds 02_2015 rds
{ Rds 10_27014 rds
Documenti Rds Stationl .rds
recenti Rds Station2.rds
=
L
Desktop
Drocumenti
Risorse del
computer
" Marme file: V| I Apri I
Risorse direte | Tipo file: |F|DS Files v | [ Annulla ]

Save Configuration

Salva con nome

Salvain | 23 Ust Presets v | O E-
Y Rels 02_2015.rds
i Rds 10_2014 rds
Documenti Rds Stationl .rds
recenti Rds Stationz.rds
=
L
Desktap
Drocumenti
Risorse del
computer
" Mome file: F:d::: ( = | I Salva I
Risorse direte | Salva come: |F|DS Files - | [ Annulla ]

The *.rds file will contain the whole RDS encoder configuration, it can be stored as a backup or used
to transfer the configuration to other devices.
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3.6

Passcode setup

MultiBand Processor Programmer Ver,

=
x
e Processor

Change Pa e
Store PassCode to disk
Serial TCP-IP = LUDP
192 . 168
54000 -

Get Info

To protect the device from unauthorized operation, a security code can be set. The default code is
0000 (security disabled), but it can be changed through the following procedure:

Put the current Passcode into the PassCode edit box (0000 by default).
Put a new code into the "New Code" and, the same again, into the "New Code Confirm" editor.
Go to Menu->PassCode->Change Passcode

The user will be prompted for passcode change confirmation, then the passcode will be changed.

Warning x

r] This precedure will change your current pass code,
Really continue?
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4 RD Link

RD-Link is a software which allows the connection of the RDS coder to the radio automation system
to allow for dynamic radiotext and radiotext Plus, TA and Clock-Time to be implemented.

At the time of writing this document, the software is already compatible with sewveral radio
automation systems, but other interfaces may be included on customer request in order to extend

the compatibility to other systems.

¥ RD-Link ¥:2.0.0.0 Raw text =13

File Tools

Filetame: C:\Documents and SettingsiItelDeskiophRT+Hbest, bk

Arkisk
SHAKIRA

a Tartura

03/03/15 09,40.41 RT+:5HAKIRA La Tortura

4.1 Radiotext Plus
Radio text plus is a complementary senice that, united with classic radiotext, enables tagging of
specific radiotext parts so that they can be isolated and used by some specialized receivers.
You can then, for example, have the complete station playlist aired for the listening period.

An example of normal radiotext tagged with radiotext plus (RT+).

The normal radiotext carries the string: "SHAKIRA - La tortura"
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A receiver with Radiotext Plus decoding capabilities will "know", for example, which part of the whole
text is the artist's name and which is the song title.

In this case, the song title and artist's name are used to compile the playlist aired by the station we
are listening.

In the case below, the radiotext string is "You are listening to Shakira with La tortura Feat. Alejandro
Sanz" and both normal radiotext and tagged radiotext are shown: first string is the artist name, the
second is the song title, last string is the normal radiotext.
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SHAKIRR
L tortors Feat Ko
tou ars lsbening 15 BHNEI

..i..-

4.2 Monitor

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Monitor

iIIS,I'DSII'IS 09,4955 RT+:5HAKIRA La tortura

On the Monitor window the dynamic PS and Radiotext strings are shown in the same way as they
are being transmitted.
It is shown also the status of TA,CT, RT+ flags and scheduler.

TA Orange : TA flag active during traffic news on air.
Gray: TA flag disabled

CT Green: transmission of Clock/Time block 4A, for remote clock visualization and
synchronization, is enabled
Gray: CT is disabled.
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RT+

SCHED

Blue: the radiotext string actually shown is tagged using radiotext plus.
Gray: Radiotext Plus is disabled.

Green:scheduler is enabled, Radiotext Plus is enabled
Red:scheduler is enabled, but actually Radiotext Plus is
disabled by the scheduler

Gray: scheduler disabled, Radiotext plus tagging is controlled
by the flag Enable RT

51
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4.3 Configuration
Open configuration menu (Tools->Configuration), and the following window will appear:
L EENCTETSEAET RN <)
|
B [ addoffset w0 o
|
431 Setup
4.3.1.1 Program ID
It is possible to assign a name to the executable window in order to recognize it quickly, when
multiple executables are running at the same time to control different coders (eg different programs
belonging to the same publishing group).
4.3.1.2 Radiotext Plus and dynamic PSN

Enable RT +: Enable radiotext plus

The strings sent by radio automation system will be passed to radiotext only if this flag is enabled.
You can also add a prefix and a separator to the string which will be put on-air.

Please note that the maximum length of radiotext string in block 2A, is 64 characters.

If the total length of the string, including prefix and separator, will be longer than this limit, it will be
truncated automatically.

Send RT + titles to PSN: Enable sending radiotext titles on PSN.

With this function, the song titles will also be sent on the PSN (maximum length is 8 characters ).
This function should be used with caution as it can cause driver distraction and in some countries is
expressly prohibited. You are advised to check your local regulations before to activate it.
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4.3.1.3

To limit driver distraction, single character scrolling has been reduced to a minimum, as the program
tries to conwey mainly whole 8 characters blocks.

Separator: separator to be inserted between title and artist. A different separator can be chosen
with respect the one used for radio text.

Scroll interval (secs): scroll time interval of a single character.
All strings which will not fit 8 characters, will be displayed by scrolling one character at a time using
this interval.

Word interval (secs): display time of a single word.
A word which has a length less than or equal to 8 characters, will be displayed for the time selected.

Repeat delay (secs): The title will be displayed again on the PSN , after this time (in seconds) is
elapsed. If the entered value is 0, the title will be displayed once at the beginning of the new song,
then the coder will send the PSN strings stored internally until the next song.

End title blank duration (secs): if set to any value other than 0, an empty PSN will be displayed for
the selected duration, once the dynamic PSN is ended and before to putting on-air the internal PSN
strings.

Sync start DyPSN: if enabled, it will start the dynamic PSN only at the end of the internally stored
strings.

Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).

Without Sync Start: "MY RADIO", "BEATLES", "HELP","THE BEST","IN TOWN","MY RADIO",
"THE BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).

With Sync Start: "MY RADIO","THE BEST","IN TOWN","BEATLES", "HELP","MY RADIO","THE
BEST","IN TOWN"(loop) (dynamic PS strings are bolded).

Restart from first PSN item after DyPs: if enabled, after a dynamic PSN is transmitted, it will
restart the display of internal strings from the beginning.

Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).

Without restarting: "MY RADIO", "BEATLES", "HELP","THE BEST","IN TOWN","MY RADIO", "THE
BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).

With restarting:: "MY RADIO", "BEATLES", "HELP","MY RADIO", "THE BEST", "IN TOWN"(loop)
(dynamic PS strings are bolded).

TA - Clock time
Enable TA: the TA flag will be switched on during traffic news.

Max duration: maximum traffic news duration. Once this time is elapsed, the TA flag, if it was
previously set on, will be automatically switched off.

TA Trigger string: it is the name, as passed to the program by the radio autiomation system, of the
traffic news audio file. If traffic news are live, this could be the name of the file used as traffic news
liner. The name is case insensitive.

Hide traffic title string on radiotext: if enabled, it will not send the string associated with the traffic
news file to radiotext or PSN.

Enable CT: enable sending CT (clock time).

© 2021 BEI Electronics LLC



54

D-PRO-6FM Audio Processor

4314

Enabling this function, it will be sent the 4A block for radio alarm clocks synchronization and date-
time visualization.

As the PC system clock will be used, it is recommended to keep the system clock synchronized
using any time senver.

The 4A block transmission will be suspended when PC is shut off or the PC-Coder communication
is broken.

Add offset: offset for the time currently sent.

Communication interface and additional settings

Max RT Duration: maximum radiotext duration.

This control sets the maximum time for the same Radiotext Plus string visualization. If this period is
exceeded, the coder will start to send the internally stored RT strings, returning to dynamic RT+
once a new string is received.

Show log: show program activity log.

Center PSN: auto center the strings displayed on PSN, if they are shorter than 8 characters.

Use scheduler for dynamic contents: enable scheduler for dynamic radiotext plus and PSN
activation, if they are supposed to be active only on some week days or at a specified time,

Create a copy of RDS file: creates an identical copy of the title file written by the automation
system to be read by other applications (eg: streaming encoder).

Save log: sawe a daily program activity log on a file eg: "log_18-06-2014.txt"

Coder interface: communication interface selection, RS232, TCP/IP or UDP.
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4.3.2

Raw Text Importer

Raw text importer allows to read plain text files generated by the radio automation system.

La tortura ; SHAKIRA

0y La kortura
1: SHAKIRA

1 4 SHAKIRA
0 4 % | |La tortura
i
o

The contents of the currently selected file (from the main window menu File-> Raw TextFile) is
displayed in the Raw Text Input.

The artist and title fields may be separated in two ways:

using separators: the strings read from the file will be divided using the characters entered in the
"Separators" editor.

In the above example, the input string "SHAKIRA;La tortura” is divided, using the separator *;".

This will produce two output lines (line O:La tortura, line 1: SHAKIRA).

Then, using the controls "Artist item" and "Title item", set which line must be used as title and which
one as the artist name.

using identifiers eventually included in the raw file: if the raw file was already marked with
labels such as:

CurrArtist = Michael Jackson

CurrTitle = Thriller

you can simply enter in the editors "Artist ID" and "Title ID" the two identifiers "CurrArtist =" and
"CurrTitle =" (without quotes).

The program will then automatically isolate strings related to artist name and song title.
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4.3.3

In both cases, pressing the "Test" button, the user will be able to experiment with different settings
of indexes, separators or identifiers.

If the checkbox "Ignore if artist or title are null" is checked, all items having no artist name or title will
be discarded.

This feature, combined with the word filter, avoids to display jingles titles, backing tracks and
everything else that must not appear in the dynamic radiotext.

Word filter

Word filter awids the visualization, on dynamic radiotext and PS, of all strings which match any
word in list.

‘Word Filter

String Mode

Unknown whole Word
Error whole Word
Fault Ay Occurrence

Fault Any Occurrence ~ | Add

Enatle word Filker

Words are added writing them in the editing line, then must be set the recognition method (Whole
Word or Any Occurrence). Pressing the "Add" button, the new word will be added to the list.

Whole word: the word to be recognized must be correspond exactly to the input string:

Example, filter word "apple": "apple" is recognized and filtered, "pineapple" is not recognized.
Any Occurrence: any occurrence of the filter word is recognized:

Example, filter word “"wide": "wide" is recognized and filtered, but also "widescreen" or
"worldwide".

Words are always compared in case-insensitive mode: setting a filter for word "Test", "TEST" or
"TeSt", will result in the same effect.
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4.4 Scheduler

The dynamic content scheduler (menu Tools->Scheduler) allows to activate the Radiotext Plus
and dynamic PSN only in predetermined time intervals.

Scheduler

@ @ (3 @

o003

Skark End Stakus
0.00.00 23.59.59 OFF

Update

Same for all days ||| Clear all schedules

For example, we want to use dynamic RT+ and PSN only from 8.00 to 12.00 and from 18.00 to
23.00 every day except on Sundays where it will be active for the entire day.

So an event must be created, scheduled for 8:00 am (set into "Start Time" box), having "Enabled"
status checked .

Pressing the "Add" the button, the event will be added to the events list.

Scheduler
@ @ (3 @
go000 3

Skark End Stakus

0.00.00 §.00,00 QOFF
8.00.00 23,5959 Ol

Same for all days ||| Clear all schedules

We hawe that the dynamic content will be disabled from 00.00 to 8.00 then, for the event we created,
from 8.00 onwards it will be enabled.

Now the dynamic content disabling event should be added: put 12:00 into the "StartTime" box,
unckeck the "Enabled" checkbox and push "Add" button.
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Scheduler

120000 %

End Skakus
5.00.00

12.00.00

23.59.59

The dynamic content has to be re-enabled from 18:00 to 23:00, so one enabling event has to be
added at 18:00 and a disabling event at 23:00.
In the following picture is represented the complete programming.

Scheduler

Skart

0.00.00 8.00.00
8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00

23.00.00 23.59.59

Summarizing: firstly the dynamic content enabling was added at 8:00hr, then the disabling event at
12:00hr, the re-enabling at 18:00hr and the disabling at 23:00hr.

Since this scheduling will be the same for almost the whole week, it can be simply copied to the
other days, pressing the "Same for all days" button.
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Once copied, it can be verified that, changing the week day selection at the top of the window, the
scheduling is the same for all days.

Done this, you will then modify the sunday scheduling only, where the dynamic content will be
enabled for the whole day.

Select the week day, on the top of the window, "Sun"

Scheduler

zzo000 3

Same for all days || Clear all schedules

Press the "Clear button" to delete all scheduler entries for the current day.
Once all entries have been deleted, just add an ewvent starting at 00:00, with "Enabled" checkbox
checked to enable the dynamic content .
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Scheduler
@ [~ @ @

00000 &

Skark End
0.00.00 23.59.59 OFF

Update

Same for all days || Clear all schedules

Programming is completed. Press "OK" button to save and exit from the current window.
Follows a short description of the other controls on the window:
Remove: removes the currently selected entry

Update: updates the currently selected entry with new time and/or status informations.
Clear all schedules: deletes all entries over all days.
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5.1

Streaming audio module

The module adds audio streaming decoding or encoding capabilities for receiving or trasmitting
streaming HLS / MP3 / AAC + shoutcast seners by HTTP/HTTPS using TCP / IP connectivity.

The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving
the highest audio quality.

Decoder audio Stream

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the login default page.

itel, pstream

No password set by default, click on the login button and enter the main page.

Go to the "Streaming settings" menu and set one or more URLs from which to receive the audio
stream.
Sawe current configuration by pressing the "Apply settings” button.

mENU itel, stream Help
o Status Status
=y Streaming settings Streaming Status

Streaming Status

&-» Network Settings

L2 System Settings

Main stream:Connected
@ OpenHelp http://192.168.1.222:6001

Back stream:Connected

(:) System Update

http://192.168.1.220:6001

¥ Download finder software

5] Logout
On Air stream:
http://192.168.1.222:6001
L Level:-0.0dB
D . . 0 . \. .
36 -30 -24 18 <12 -6 3 0
R Level:-0.0 dB
. g . . . ‘. .
30 24 18 12 6 3 0
Buffer Level: 100
o 50 100

Metadata

Metwork Status

This page displays the status of the
main and backup streams, the URL
of the two streams,the metadata
provided by main and backupe
streams, the status of the pre-buffers
expressed as a percentage and
audio levels of on-air source.

The on-air chain priority is MAIN
STREAM->BACKUP STREAM

Network Status

This page displays the network
configurations for the ethernet
interface.

System Status

This page shows the status of the
system and provide info about
firmware version, mac addresses,
uptime and global configuration.

System Log

Shows the system activity log
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The module adds audio streaming decoding capabilities for receiving streaming MP3 / AAC + / HLS
shoutcast seners or by using TCP / IP connectivity.

The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving
the highest audio quality.

An helpful guide for all settings appears on the side of the configuration page.

On the audio processor, now select the audio input "NetAudio” and the streaming audio received by
the module should be put on-air.

Adjust, if necessary, the input level of audio input "netaudio.” If you intend to use any audio
processing during streaming audio playback, this setting can also be omitted since the processor
will provide for automatic leveling.

The preset for the network input can be chosen into the next window, after "netaudio” input has been
selected into the current.

If you want to use more than a single audio source, for using the integrated automatic audio fallback,
proceed to its selection and its associated audio processing preset.

Finally, turn the audio fallback on.

52 Encoder audio Sream

|_Home | CoNFIGURATION | STATUS | DEFAULTS | UPDATE | REsoor | MAC:O0OGEIOL:A7:95 FWV0405 |

itel
m Stream Streaming Mode send always Help
Format MPEGH /40 ke Listen Olos
Click the link to get the online Shoutcast stream of the
Audio Peak Left A0 dB [— Instreamer {as M3U playlist) to play on your PC. For proper

Input operation make sure you configure MP3 encoding and send

Peak Right 12 dB - Shvare

Status EICO Active Connections

Lists all active TCP and BRTP connections o the Instreamer.
Al TCP connections are listed That includes web page
access, Internet radios, raw TCP. Shoutcast and Icacast
connections. A TCP connection is listed if and only if it's in the
“established” state.

Stream
Streaming Mode
» "send aiways” - the device streams permanently
+ “send on CTS"- the device streams if CTS input on
RS-232 interface is activated
= "send on I/Q" - the device streams if the selected digital
input is activated
"send on leve!” - the device streams if the input audio
peak reaches the configured level
Audio Format
Displays the current streaming format and sampling
frequency
Audio Input
Peak Left and Right
The numbers [in dB full-scale] and the graphical VU meters
show the peak values of the analog audio inputs (fine or

microphone)
Max. value is 0 dB.

The audio streaming encoder module has the task of generating a streaming stream in the IP
network, various encoding formats allow the transmission of the audio generated by the processor
ower the network to shoutcast / icecast servers, even in low latency, using RTP, UDP, Multicast or
TCP / IP connectivity.

AvailableCodec:

e MP3 fino a 320kbps, (VBR e CBR),

e PCM 16bit @8, 16, 22.05, 24, 32, 44.1, 48 kHz
e G.711, uLaw, aLaw
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5.3

An helpful guide for all settings appears on the side of the configuration page.

Quick setup

The default IP address is 192.168.1.100.
If the IP is unknown, connect the the processor directly to a PC network card, then use the supplied
utility "module_finder.exe" to recover its IP address.

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the default page.

Go to the "CONFIG" menu and set one or more URLs from which to receive the audio stream.
Save current configuration by pressing the "SAVE & REBOOT" button, wait for the restart of the
module.

Configure the network settings of the module: SETUP -> NETWORK
Sawe by pressing the "SAVE & REBOOT" button, wait for the restart of the module.
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